Prepare for installing the SnapCenter
Server

SnapCenter Software 5.0

NetApp
October 15, 2025

This PDF was generated from https://docs.netapp.com/us-en/snapcenter-
50/install/reference_domain_and_workgroup_requirements.html on October 15, 2025. Always check

docs.netapp.com for the latest.



Table of Contents

Prepare for installing the SnapCenter Server
Domain and workgroup requirements
Space and sizing requirements
SAN host requirements
Supported storage systems and applications
Supported browsers
Connection and port requirements
SnapCenter licenses
Single Mailbox Recovery (SMBR) licenses
Authentication methods for your credentials
Windows authentication
Untrusted domain authentication
Local workgroup authentication
SQL Server authentication
Linux authentication
AIX authentication
Oracle database authentication
Oracle ASM authentication
RMAN catalog authentication
Storage connections and credentials
Multi-factor authentication (MFA)
Manage multi-factor authentication (MFA)
Manage multi-factor authentication (MFA) using Rest API, PowerShell, and SCCLI
Configure MFA in SnapCenter Server using PowerShell, SCCLI, and REST API

© © © © © © 00O W W WN =2 2

A A 1 A = A A
o A o~ A O O O O ©



Prepare for installing the SnapCenter Server

Domain and workgroup requirements

The SnapCenter Server can be installed on systems that are either in a domain or in
workgroup. The user used for installation should have admin privileges on the machine in
case of both workgroup and domain.

For installing SnapCenter Server and SnapCenter plug-ins on Windows hosts, you should use one of the
following:

* Active Directory domain

You must use a Domain user with local administrator rights. The Domain user must be a member of the
local Administrator group on the Windows host.

* Workgroups

You must use a local account that has local administrator rights.

While domain trusts, multi-domain forests, and cross-domain trusts are supported, cross-forest domains are
not supported. The Microsoft documentation about Active Directory Domains and Trusts contains more
information.

After installing the SnapCenter Server, you should not change the domain in which the

@ SnapCenter host is located. If you remove the SnapCenter Server host from the domain it was
in when the SnapCenter Server was installed and then try to uninstall SnapCenter Server, the
uninstall operation fails.

Space and sizing requirements

Before you install the SnapCenter Server, you should be familiar with the space and
sizing requirements. You should also apply the available system and security updates.
Item Requirements

Operating Systems Microsoft Windows

Only English, German, Japanese, and simplified
Chinese version of the operating systems are
supported.

For the latest information about supported versions,
see NetApp Interoperability Matrix Tool.

Minimum CPU count 4 cores


https://imt.netapp.com/matrix/imt.jsp?components=116859;&solution=1257&isHWU&src=IMT

Item Requirements

Minimum RAM 8 GB

@ The MySQL Server buffer pool uses 20
percent of the total RAM.

Minimum hard drive space for the SnapCenter Server 4 GB
software and logs

If you have the SnapCenter repository
@ in the same drive where SnapCenter

Server is installed, then it is

recommended to have 10 GB.

Minimum hard drive space for the SnapCenter 6 GB
repository
NOTE: If you have the SnapCenter
@ Server in the same drive where
SnapCenter repository is installed, then
it is recommended to have 10 GB.

Required software packages * Microsoft .NET Framework 4.7.2 or later

* Windows Management Framework (WMF) 4.0 or
later

» PowerShell 4.0 or later
For .NET specific troubleshooting information, see

SnapCenter upgrade or install fails for legacy systems
that do not have internet connectivity.

SAN host requirements

If your SnapCenter host is part of a FC/iSCSI environment, you might need to install
additional software on the system to enable access to ONTAP storage.

SnapCenter does not include Host Utilities or a DSM. If your SnapCenter host is part of a SAN environment,
you might need to install and configure the following software:

* Host Utilities

The Host Utilities support FC and iSCSI, and it enables you to use MPIO on your Windows Servers. For
information, see Host Utilities documentation.

* Microsoft DSM for Windows MPIO

This software works with Windows MPIO drivers to manage multiple paths between NetApp and Windows
host computers.

A DSM is required for high availability configurations.


https://kb.netapp.com/Advice_and_Troubleshooting/Data_Protection_and_Security/SnapCenter/SnapCenter_upgrade_or_install_fails_with_%22This_KB_is_not_related_to_the_OS%22
https://kb.netapp.com/Advice_and_Troubleshooting/Data_Protection_and_Security/SnapCenter/SnapCenter_upgrade_or_install_fails_with_%22This_KB_is_not_related_to_the_OS%22
https://docs.netapp.com/us-en/ontap-sanhost/

@ If you were using ONTAP DSM, you should migrate to Microsoft DSM. For more information,
see How to migrate from ONTAP DSM to Microsoft DSM.

Supported storage systems and applications

You should know the supported storage system, applications, and databases.

* SnapCenter supports ONTAP 9.8 and later to protect your data.

» SnapCenter supports Amazon FSx for NetApp ONTAP to protect your data from SnapCenter Software 4.5
P1 patch release.

If you are using Amazon FSx for NetApp ONTAP, ensure that the SnapCenter Server host plug-ins are
upgraded to 4.5 P1 or later to perform data protection operations.

For information about Amazon FSx for NetApp ONTAP, see Amazon FSx for NetApp ONTAP
documentation.

» SnapCenter supports protection of different applications and databases.

For detailed information about the supported applications and databases, see NetApp Interoperability
Matrix Tool.

» SnapCenter 4.9 P1 and later supports protection of Oracle and Microsoft SQL workloads in VMware Cloud
on Amazon Web Services (AWS) Software-Defined Data Center (SDDC) environments.

For more information, see Protect Oracle, MS SQL workloads using NetApp SnapCenter in VMware Cloud
on AWS SDDC environments.

Supported browsers
SnapCenter Software can be used on multiple browsers.
» Chrome
If you are using v66, you might fail to launch SnapCenter GUI.
* Microsoft Edge 110.0.1587.17 and later

For the latest information about supported versions, see NetApp Interoperability Matrix Tool.

Connection and port requirements

You should ensure that the connections and ports requirements are met before installing
the SnapCenter Server and application or database plug-ins.

 Applications cannot share a port.
Each port must be dedicated to the appropriate application.

* For customizable ports, you can select a custom port during installation if you do not want to use the


https://kb.netapp.com/Advice_and_Troubleshooting/Data_Storage_Software/Data_ONTAP_DSM_for_Windows_MPIO/How_to_migrate_from_Data_ONTAP_DSM_4.1p1_to_Microsoft_native_DSM
https://docs.aws.amazon.com/fsx/latest/ONTAPGuide/what-is-fsx-ontap.html
https://docs.aws.amazon.com/fsx/latest/ONTAPGuide/what-is-fsx-ontap.html
https://imt.netapp.com/matrix/imt.jsp?components=116859;&solution=1257&isHWU&src=IMT
https://imt.netapp.com/matrix/imt.jsp?components=116859;&solution=1257&isHWU&src=IMT
https://community.netapp.com/t5/Tech-ONTAP-Blogs/Protect-Oracle-MS-SQL-workloads-using-NetApp-SnapCenter-in-VMware-Cloud-on-AWS/ba-p/449168
https://community.netapp.com/t5/Tech-ONTAP-Blogs/Protect-Oracle-MS-SQL-workloads-using-NetApp-SnapCenter-in-VMware-Cloud-on-AWS/ba-p/449168
https://imt.netapp.com/matrix/imt.jsp?components=116859;&solution=1257&isHWU&src=IMT

default port.

You can change a plug-in port after installation by using the Modify Host wizard.

* For fixed ports, you should accept the default port number.

e Firewalls

o Firewalls, proxies, or other network devices should not interfere with connections.

o If you specify a custom port when you install SnapCenter, you should add a firewall rule on the plug-in
host for that port for the SnapCenter Plug-in Loader.

The following table lists the different ports and their default values.

Type of port
SnapCenter web port

SnapCenter SMCore communication port

MySQL port

Default port

8146 (HTTPS), bidirectional, customizable, as in the
URL https://server:8146

Used for communication between the SnapCenter
client (the SnapCenter user) and the SnapCenter
Server. Also used for communication from the plug-in
hosts to the SnapCenter Server.

To customize the port, see Install the SnapCenter
Server using the install wizard.

8145 (HTTPS), bidirectional, customizable

The port is used for communication between the
SnapCenter Server and the hosts where the
SnapCenter plug-ins are installed.

To customize the port, see Install the SnapCenter
Server using the install wizard.

3306 (HTTPS), bidirectional

The port is used for communication between
SnapCenter and MySQL repository database.

You can create secured connections from the
SnapCenter Server to the MySQL server. Learn more

To customize the port, see Install the SnapCenter
Server using the install wizard.


https://docs.netapp.com/us-en/snapcenter/install/task_install_the_snapcenter_server_using_the_install_wizard.html
https://docs.netapp.com/us-en/snapcenter/install/task_install_the_snapcenter_server_using_the_install_wizard.html
https://docs.netapp.com/us-en/snapcenter/install/task_install_the_snapcenter_server_using_the_install_wizard.html
https://docs.netapp.com/us-en/snapcenter/install/task_install_the_snapcenter_server_using_the_install_wizard.html
https://docs.netapp.com/us-en/snapcenter-50/install/concept_configure_secured_mysql_connections_with_snapcenter_server.html
https://docs.netapp.com/us-en/snapcenter/install/task_install_the_snapcenter_server_using_the_install_wizard.html
https://docs.netapp.com/us-en/snapcenter/install/task_install_the_snapcenter_server_using_the_install_wizard.html

Type of port

Windows plug-in hosts

Linux or AIX plug-in hosts

SnapCenter Plug-ins Package for Windows,
SnapCenter Plug-ins Package for Linux or
SnapCenter Plug-ins Package for AIX

SnapCenter Plug-in for Oracle Database

Default port
135, 445 (TCP)

In addition to ports 135 and 445, the dynamic port
range specified by Microsoft should also be open.
Remote install operations use the Windows
Management Instrumentation (WMI) service, which
dynamically searches this port range.

For information on the dynamic port range supported,
see Service overview and network port requirements
for Windows

The ports are used for communication between the
SnapCenter Server and the host on which the plug-in
is being installed. To push plug-in package binaries to
Windows plug-in hosts, the ports must be open only
on the plug-in host, and they can be closed after
installation.

22 (SSH)

The ports are used for communication between the
SnapCenter Server and the host where the plug-in is
being installed. The ports are used by SnapCenter to
copy plug-in package binaries to Linux or AIX plug-in
hosts and should be open or excluded from the
firewall or iptables.

8145 (HTTPS), bidirectional, customizable

The port is used for communication between SMCore
and hosts where the plug-ins package is installed.

The communication path also needs to be open
between the SVM management LIF and the
SnapCenter Server.

To customize the port, see Add hosts and install
SnapCenter Plug-in for Microsoft Windows or Add
hosts and install SnapCenter Plug-ins package for
Linux or AlX.

27216, customizable

The default JDBC port is used by the plug-in for
Oracle for connecting to the Oracle database.

To customize the port, see Add hosts and install
SnapCenter Plug-ins package for Linux or AIX.


https://support.microsoft.com/kb/832017
https://support.microsoft.com/kb/832017
https://docs.netapp.com/us-en/snapcenter/protect-scw/task_add_hosts_and_install_snapcenter_plug_in_for_microsoft_windows.html
https://docs.netapp.com/us-en/snapcenter/protect-scw/task_add_hosts_and_install_snapcenter_plug_in_for_microsoft_windows.html
https://docs.netapp.com/us-en/snapcenter/protect-sco/task_add_hosts_and_installing_the_snapcenter_plug_ins_package_for_linux_or_aix.html
https://docs.netapp.com/us-en/snapcenter/protect-sco/task_add_hosts_and_installing_the_snapcenter_plug_ins_package_for_linux_or_aix.html
https://docs.netapp.com/us-en/snapcenter/protect-sco/task_add_hosts_and_installing_the_snapcenter_plug_ins_package_for_linux_or_aix.html
https://docs.netapp.com/us-en/snapcenter/protect-sco/task_add_hosts_and_installing_the_snapcenter_plug_ins_package_for_linux_or_aix.html
https://docs.netapp.com/us-en/snapcenter/protect-sco/task_add_hosts_and_installing_the_snapcenter_plug_ins_package_for_linux_or_aix.html

Type of port

Custom plug-ins for SnapCenter

ONTAP cluster or SVM communication port

SnapCenter Plug-in for SAP HANA Database vCode
Spell Checkerports

Domain controller communication port

To modify the port details, see Modify plug-in hosts.

SnapCenter licenses

Default port
9090 (HTTPS), fixed

This is an internal port that is used only on the custom
plug-in host; no firewall exception is required.

Communication between the SnapCenter Server and
custom plug-ins is routed through port 8145.

443 (HTTPS), bidirectional80 (HTTP), bidirectional

The port is used by the SAL (Storage Abstraction
Layer) for communication between the host running
SnapCenter Server and SVM. The port is currently
also used by the SAL on SnapCenter for Windows
Plug-in hosts for communication between the
SnapCenter plug-in host and SVM.

3instance_number13 or 3instance_number15, HTTP
or HTTPS, bidirectional, and customizable

For a multitenant database container (MDC) single
tenant, the port number ends with 13; for non MDC,
the port number ends with 15.

For example, 32013 is the port number for instance
20 and 31015 is the port number for instance 10.

To customize the port, see Add hosts and install plug-
in packages on remote hosts.

See the Microsoft documentation to identify the ports
that should be opened in the firewall on a domain
controller for authentication to work properly.

It is necessary to open the Microsoft required ports on
the domain controller so that the SnapCenter Server,
Plug-in hosts, or other Windows client can
authenticate the users.

SnapCenter requires several licenses to enable data protection of applications,
databases, file systems, and virtual machines. The type of SnapCenter licenses you
install depends on your storage environment and the features that you want to use.


https://docs.netapp.com/us-en/snapcenter/protect-hana/task_add_hosts_and_install_plug_in_packages_on_remote_hosts_sap_hana.html
https://docs.netapp.com/us-en/snapcenter/protect-hana/task_add_hosts_and_install_plug_in_packages_on_remote_hosts_sap_hana.html
https://docs.netapp.com/us-en/snapcenter-50/admin/concept_manage_hosts.html#modify-plug-in-hosts

License

SnapCenter Standard controller-based

SnapCenter Standard capacity-based

SnapMirror or SnapVault

SnapRestore

Where required

Required for FAS, AFF, All SAN Array (ASA)

SnapCenter Standard license is a controller-based
license and is included as part of the premium bundle.
If you have the SnapManager Suite license, you also
get the SnapCenter Standard license entitlement. If
you want to install SnapCenter on a trial basis with
FAS, AFF, or ASA storage, you can obtain a Premium
Bundle evaluation license by contacting the sales
representative.

SnapCenter is also offered as part of
@ data protection bundle. If you have

purchased A400 or later, you should

purchase the data protection bundle.

Required with ONTAP Select and Cloud Volumes
ONTAP

If you are a Cloud Volumes ONTAP or ONTAP Select
customer, you need to procure a per TB capacity-
based license based on the data managed by
SnapCenter. By default, SnapCenter ships a built-in
90-day 100 TB SnapCenter Standard capacity-based
trial license. For other details, contact the sales
representative.

ONTAP

Either SnapMirror or SnapVault license is required if
replication is enabled in SnapCenter.

Required to restore and verify backups.
On primary storage systems

* Required on SnapVault destination systems to
perform remote verification and to restore from a
backup.

* Required on SnapMirror destination systems to
perform remote verification.



License Where required
FlexClone Required to clone databases and verification
operations.
On primary and secondary storage systems
» Required on SnapVault destination systems to
create clones from secondary vault backup.

* Required on SnapMirror destination systems to
create clones from secondary SnapMirror backup.

iISCSI or FC license for LUNs

CIFS license for SMB shares

* NFS license for NFS type VMDKs

iSCSI or FC license for VMFS type VMDKs

Protocols

Required on SnapMirror destination systems to serve
data if a source volume is unavailable.

SnapCenter Standard licenses (optional) Secondary destinations

It is recommended, but not required,
that you add SnapCenter Standard
licenses to secondary destinations. If
SnapCenter Standard licenses are not
enabled on secondary destinations,

@ you cannot use SnapCenter to backup
resources on the secondary destination
after performing a failover operation.
However, a FlexClone license is
required on secondary destinations to
perform clone and verification
operations.

@ SnapCenter Advanced and SnapCenter NAS File Services licenses are deprecated, and are no
longer available.

You should install one or more SnapCenter licenses. For information on how to add licenses, see Add
SnapCenter Standard controller-based licenses or Add SnapCenter Standard capacity-based licenses.

Single Mailbox Recovery (SMBR) licenses

If you are using SnapCenter Plug-in for Exchange to manage Microsoft Exchange Server databases and
Single Mailbox Recovery (SMBR), you would need additional license for SMBR which needs to be purchased
separately based on user mailbox.

NetApp® Single Mailbox Recovery has come to the end of availability (EOA) on May 12, 2023. For more
information, refer CPC-00507. NetApp will continue to support customers that have purchased mailbox
capacity, maintenance, and support through marketing part numbers introduced on June 24, 2020, for the


https://docs.netapp.com/us-en/snapcenter-50/install/concept_snapcenter_standard_controller_based_licenses.html
https://docs.netapp.com/us-en/snapcenter-50/install/concept_snapcenter_standard_controller_based_licenses.html
https://docs.netapp.com/us-en/snapcenter-50/install/concept_snapcenter_standard_capacity_based_licenses.html
https://mysupport.netapp.com/info/communications/ECMLP2885729.html

duration of the support entitlement.

NetApp Single Mailbox Recovery is a partner product provided by Ontrack. Ontrack PowerControls offers
capabilities that are similar to those of NetApp Single Mailbox Recovery. Customers can procure new Ontrack
PowerControls software licenses and Ontrack PowerControls maintenance and support renewals from Ontrack
(through licensingteam@ontrack.com) for granular mailbox recovery after the May 12, 2023, EOA date.

Authentication methods for your credentials

Credentials use different authentication methods depending upon the application or
environment. Credentials authenticate users so they can perform SnapCenter operations.
You should create one set of credentials for installing plug-ins and another set for data
protection operations.

Windows authentication

The Windows authentication method authenticates against Active Directory. For Windows authentication,
Active Directory is set up outside of SnapCenter. SnapCenter authenticates with no additional configuration.
You need a Windows credential to perform tasks such as adding hosts, installing plug-in packages, and
scheduling jobs.

Untrusted domain authentication

SnapCenter allows the creation of Windows credentials using users and groups belonging to the untrusted
domains. For the authentication to succeed, you should register the untrusted domains with SnapCenter.

Local workgroup authentication

SnapCenter allows the creation of Windows credentials with local workgroup users and groups. The Windows
authentication for local workgroup users and groups does not happen at the time of Windows credential
creation but is deferred until the host registration and other host operations are performed.

SQL Server authentication

The SQL authentication method authenticates against a SQL Server instance. This means that a SQL Server
instance must be discovered in SnapCenter. Therefore, before adding a SQL credential, you must add a host,
install plug-in packages, and refresh resources. You need SQL Server authentication for performing operations
such as scheduling on SQL Server or discovering resources.

Linux authentication

The Linux authentication method authenticates against a Linux host. You need Linux authentication during the
initial step of adding the Linux host and installing the SnapCenter Plug-ins Package for Linux remotely from the
SnapCenter GUI.

AlIX authentication

The AlX authentication method authenticates against an AlX host. You need AIX authentication during the
initial step of adding the AIX host and installing the SnapCenter Plug-ins Package for AIX remotely from the
SnapCenter GUI.


mailto:licensingteam@ontrack.com

Oracle database authentication

The Oracle database authentication method authenticates against an Oracle database. You need an Oracle
database authentication to perform operations on the Oracle database if the operating system (OS)
authentication is disabled on the database host. Therefore, before adding a Oracle database credential, you
should create an Oracle user in the Oracle database with sysdba privileges.

Oracle ASM authentication

The Oracle ASM authentication method authenticates against an Oracle Automatic Storage Management
(ASM) instance. If you are required to access the Oracle ASM instance and if the operating system (OS)
authentication is disabled on the database host, you need an Oracle ASM authentication. Therefore, before
adding an Oracle ASM credential, you should create an Oracle user with sysasm privileges in the ASM
instance.

RMAN catalog authentication

The RMAN catalog authentication method authenticates against the Oracle Recovery Manager (RMAN)
catalog database. If you have configured an external catalog mechanism and registered your database to
catalog database, you need to add RMAN catalog authentication.

Storage connections and credentials

Before performing data protection operations, you should set up the storage connections
and add the credentials that the SnapCenter Server and the SnapCenter plug-ins will
use.

» Storage connections

The storage connections give the SnapCenter Server and SnapCenter plug-ins access to the ONTAP
storage. Setting up these connections also involves configuring AutoSupport and Event Management
System (EMS) features.
* Credentials
o Domain administrator or any member of the administrator group
Specify the domain administrator or any member of the administrator group on the system on which
you are installing the SnapCenter plug-in. Valid formats for the Username field are:
= NetBIOS\UserName
= Domain FQDN\UserName
= UserName@upn
o Local administrator (for workgroups only)
For systems that belong to a workgroup, specify the built-in local administrator on the system on which
you are installing the SnapCenter plug-in. You can specify a local user account that belongs to the local

administrators group if the user account has elevated privileges or the User Access control feature is
disabled on the host system.

The valid format for the Username field is: UserName

10



> Credentials for individual resource groups

If you set up credentials for individual resource groups and the username does not have full admin
privileges, you must assign at least the resource group and backup privileges to the username.

Multi-factor authentication (MFA)

Manage multi-factor authentication (MFA)

You can manage Multi-factor authentication (MFA) functionality in the Active Directory
Federation Service (AD FS) Server and SnapCenter Server.

Enable multi-factor authentication (MFA)

You can enable MFA functionality for SnapCenter Server using PowerShell commands.

About this task

« SnapCenter supports SSO based logins when other applications are configured in the same AD FS. In
certain AD FS configurations, SnapCenter might require user authentication for security reasons
depending on the AD FS session persistence.

» The information regarding the parameters that can be used with the cmdlet and their descriptions can be
obtained by running Get-Help command name. Alternatively, you can also see SnapCenter Software
Cmdlet Reference Guide.

Before you begin
» Windows Active Directory Federation Service (AD FS) should be up and running in the respective domain.

* You should have an AD FS supported Multi-factor authentication service such as Azure MFA, Cisco Duo,
and so on.

« SnapCenter and AD FS server timestamp should be the same regardless of the timezone.

» Procure and configure the authorized CA certificate for SnapCenter Server.
CA Certificate is mandatory for the following reasons:
o Ensures that the ADFS-F5 communications do not break because the self-signed certificates are

unique at the node level.

o Ensures that during upgrade, repair, or disaster recovery (DR) in a standalone or high availability
configuration, the self-signed certificate does not get recreated thus avoiding MFA reconfiguration.

o Ensures IP-FQDN resolutions.

For information on CA certificate, see Generate CA Certificate CSR file.

Steps
1. Connect to the Active Directory Federation Services (AD FS) host.

2. Download AD FS federation metadata file from "https://<host FQDN>/FederationMetadata/2007-
06/FederationMetadata.xml".

3. Copy the downloaded file to SnapCenter Server to enable MFA feature.

4. Log in to SnapCenter Server as the SnapCenter Administrator user through PowerShell.

11
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5. Using the PowerShell session, generate the SnapCenter MFA metadata file by using the New-
SmMuiltifactorAuthenticationMetadata -path cmdlet.

The path parameter specifies the path to save the MFA metadata file in the SnapCenter Server host.

6. Copy the generated file to the AD FS host to configure SnapCenter as the client entity.
7. Enable MFA for SnapCenter Server using the Set-SmMultiFactorAuthentication cmdlet.

8. (Optional) Check the MFA configuration status and settings by using Get-
SmMultiFactorAuthentication cmdlet.

9. Go to the Microsoft management console (MMC) and perform the following steps:
. Click File > Add/Remove Snapin.

a
b. In the Add or Remove Snap-ins window, select Certificates and then click Add.

3]

In the Certificates snap-in window, select the Computer account option, and then click Finish.
d. Click Console Root > Certificates — Local Computer > Personal > Certificates.

e. Right-click on the CA certificate bound to SnapCenter and then select All Tasks > Manage Private
Keys.

f. On the permissions wizard perform the following steps:
i. Click Add.
i. Click Locations and select the concerned host (top of hierarchy).
ii. Click OK in the Locations pop-up window.
iv. In the object name field, enter ‘IIS_IUSRS’ and click Check Names and click OK.

If the check is successful, click OK.

10. In the AD FS host, open AD FS management wizard and perform the following steps:

a. Right click on Relying Party Trusts > Add Relying Party Trust > Start.

o

Select the second option and browse the SnapCenter MFA Metadata file and click Next.
Specify a display name and click Next.

Choose an access control policy as required and click Next.

Select the settings in the next tab to default.

Click Finish.

-~ ©®© Qo o

SnapCenter is now reflected as a relying party with the provided display name.

11. Select the name and perform the following steps:
a. Click Edit Claim Issuance Policy.
b. Click Add Rule and click Next.
Specify a name for the claim rule.
Select Active Directory as the attribute store.
Select the attribute as User-Principal-Name and the outgoing claim type as Name-ID.
Click Finish.

-~ ©®© o o

12. Run the following PowerShell commands on the ADFS server.
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Set-AdfsRelyingPartyTrust -TargetName ‘<Display name of relying party >’
-SigningCertificateRevocationCheck None

Set-AdfsRelyingPartyTrust -TargetName ‘<Display name of relying party >’
-EncryptionCertificateRevocationCheck None
13. Perform the following steps to confirm that the metadata was imported successfully.
a. Right-click the relying party trust and select Properties.
b. Ensure that the Endpoints, Identifiers, and Signature fields are populated.
14. Close all the browser tabs and reopen a browser to clear the existing or active session cookies, and login
again.

SnapCenter MFA functionality can also be enabled using REST APlIs.

For troubleshooting information, refer to Simultaneous login attempts in multiple tabs shows MFA error.

Update AD FS MFA Metadata

You should update the AD FS MFA metadata in SnapCenter whenever there is any modification in the AD FS
Server, such as upgrade, CA certificate renewal, DR, and so on.

Steps

1. Download AD FS federation metadata file from "https://<host FQDN>/FederationMetadata/2007-
06/FederationMetadata.xml"

2. Copy the downloaded file to SnapCenter Server to update the MFA configuration.
3. Update the AD FS metadata in SnapCenter by running the following cmdlet:

Set-SmMultiFactorAuthentication -Path <location of ADFS MFA metadata xml file>

4. Close all the browser tabs and reopen a browser to clear the existing or active session cookies, and login
again.

Update SnapCenter MFA metadata

You should update the SnapCenter MFA metadata in AD FS whenever there is any modification in ADFS
server such as repair, CA certificate renewal, DR, and so on.

Steps
1. In the AD FS host, open AD FS management wizard and perform the following steps:

a. Click Relying Party Trusts.
b. Right click on the relying party trust that was created for SnapCenter and click Delete.

The user defined name of the relying party trust will be displayed.
c. Enable Multi-factor authentication (MFA).
See Enable Multi-factor authentication.

2. Close all the browser tabs and reopen a browser to clear the existing or active session cookies, and login
again.

13


https://kb.netapp.com/mgmt/SnapCenter/SnapCenter_MFA_login_error_The_SAML_message_response_1_doesnt_match_the_expected_response_2

Disable Multi-factor authentication (MFA)

Steps

1. Disable MFA and clean up the configuration files that were created when MFA was enabled by using the
Set-SmMultiFactorAuthentication cmdlet.

2. Close all the browser tabs and reopen a browser to clear the existing or active session cookies, and login
again.

Manage multi-factor authentication (MFA) using Rest APIl, PowerShell, and SCCLI

MFA login is supported from browser, REST API, PowerShell, and SCCLI. MFA is
supported through an AD FS identity manager. You can enable MFA, disable MFA, and
configure MFA from GUI, REST API, PowerShell, and SCCLI.

Setup AD FS as OAuth/OIDC

Configure AD FS using Windows GUI wizard

1. Navigate to Server Manager Dashboard > Tools > ADFS Management.
2. Navigate to ADFS > Application Groups.

a. Right-click on Application Groups.

b. Select Add Application group and enter Application Name.

c. Select Server Application.

d. Click Next.
3. Copy Client Identifier.

This is the Client ID. .. Add Callback URL (SnapCenter Server URL) in Redirect URL. .. Click Next.
4. Select Generate shared secret.
Copy the secret value. This is the client’s secret. .. Click Next.

5. On the Summary page, click Next.
a. On the Complete page, click Close.
6. Right-click on the newly added Application Group and select Properties.
7. Select Add application from App Properties.
8. Click Add application.

Select Web API and click Next.
9. On the Configure Web API page, enter the SnapCenter Server URL and Client Identifier created in the
previous step into the Identifier section.
a. Click Add.
b. Click Next.

10. On the Choose Access Control Policy page, select control policy based on your requirement (For
example, Permit everyone and require MFA) and click Next.

11. On the Configure Application Permission page, by default openid is selected as a scope, click Next.
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12. On the Summary page, click Next.
On the Complete page, click Close.

13. On the Sample Application Properties page, click OK.

14. JWT token issued by an authorization server (AD FS) and intended to be consumed by the resource.
The 'aud' or audience claim of this token must match the identifier of the resource or Web API.

15. Edit the selected WebAPI and check that Callback URL (SnapCenter Server URL) and the client identifier
were added correctly.

Configure OpenlID Connect to provide a username as claims.

16. Open the AD FS Management tool located under the Tools menu at the top right of the Server Manager.
a. Select the Application Groups folder from the left sidebar.
b. Select the Web API and click EDIT.
c¢. Go-to Issuance Transform Rules Tab
17. Click Add Rule.
a. Select the Send LDAP Attributes as Claims in the Claim rule template dropdown.
b. Click Next.
18. Enter the Claim rule name.
a. Select Active Directory in the Attribute store dropdown.

b. Select User-Principal-Name in the LDAP Attribute dropdown and UPN in the O*utgoing Claim Type*
dropdown.

c. Click Finish.

Create Application Group using PowerShell commands

You can create the application group, web API, and add the scope and claims using PowerShell commands.
These commands are available in automated script format. For more information see <link to KB article>.

1. Create the new Application Group in AD FS by using the following comamnd.

New-AdfsApplicationGroup -Name $ClientRoleldentifier
-ApplicationGroupIdentifier $ClientRolelIdentifier

ClientRolelIdentifier name of your application group
redirectURL valid URL for redirection after authorization

2. Create the AD FS Server Application and generate the client secret.
Add-AdfsServerApplication -Name "S$ClientRoleldentifier - Server app"
-ApplicationGroupIdentifier $ClientRolelIdentifier -RedirectUri $redirectURL

—-Identifier $identifier -GenerateClientSecret

3. Create the ADFS Web API application and configure the policy name it should use.
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Sidentifier = (New-Guid) .Guid

Add-AdfsWebApiApplication -ApplicationGroupIdentifier $ClientRoleIdentifier
-Name "App Web API"

-Identifier $identifier -AccessControlPolicyName "Permit everyone"

. Get the client ID and client secret from the output of the following commands because, it is shown only one

time.
"client id = $Sidentifier"

"client secret: "$(SADFSApp.ClientSecret)

. Grant the AD FS Application the allatclaims and openid permissions.

Grant-AdfsApplicationPermission -ClientRoleldentifier $identifier
-ServerRoleIldentifier $identifier -ScopeNames @ ('openid')

Stransformrule = @"

@RuleTemplate = "LdapClaims"

@RuleName = "AD User properties and Groups"
c: [Type ==

"http://schemas.microsoft.com/ws/2008/06/identity/claims/windowsaccountname",
Issuer ==

"AD AUTHORITY"]
= 1issue(store = "Active Directory", types =
("http://schemas.xmlsoap.org/ws/2005/05/identity/claims/upn"), query =

";userPrincipalName; {0}", param = c.Value);

"@

. Write out the transform rules file.

Stransformrule |Out-File -FilePath .\issueancetransformrules.tmp -force
-Encoding ascii $relativePath = Get-Item .\issueancetransformrules.tmp

. Name the Web API Application and define its Issuance Transform Rules using an external file.

Set-AdfsWebApiApplication -Name "$ClientRoleldentifier - Web API"
-TargetIdentifier

Sidentifier -Identifier $identifier, $redirectURL -IssuanceTransformRulesFile

SrelativePath



Update access token expiry time
You can update the access token expiry time using the PowerShell command.

About this task

* An access token can be used only for a specific combination of user, client, and resource. Access tokens
cannot be revoked and are valid until their expiry.

By default, the expiry time of an access token is 60 minutes. This minimal expiry time is sufficient and
scaled. You must provide sufficient value to avoid any ongoing business-critical jobs.

Step

To update the access token expiry time for an application group WebApi, use the following command in AD FS
server.

+ Set-AdfsWebApiApplication -TokenLifetime 3600 -TargetName "<Web API>"

Get the bearer token from AD FS

You should fill the below-mentioned parameters in any REST client (like Postman) and it prompts you to fill in
the user credentials. Additionally, you should enter the second-factor authentication (something you have &
something you are) to get the bearer token.

+ The validity of the bearer token is configurable from the AD FS server per application and the default validity
period is 60 minutes.

Field Value
Grant type Authorization Code
Callback URL Enter your application’s base URL if you do not have

a callback URL.

Auth URL [adfs-domain-name]/adfs/oauth2/authorize

Access token URL [adfs-domain-name]/adfs/oauth2/token

Client ID Enter the AD FS client ID

Client secret Enter the AD FS client secret

Scope OpenlID

Client Authentication Send as Basic AUTH Header

Resource In the Advance Options tab, add the Resource field

with the same value as the Callback URL, which
comes as an “aud” value in the JWT token.
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Configure MFA in SnapCenter Server using PowerShell, SCCLI, and REST API
You can configure MFA in SnapCenter Server using PowerShell, SCCLI, and REST API.

SnapCenter MFA CLI authentication

In PowerShell and SCCLI, the existing cmdlet (Open-SmConnection) is extended with one more field called
"AccessToken" to use the bearer token to authenticate the user.

Open-SmConnection -Credential <PSCredential> [-SMSbaseUrl <String>] [-Port
<String>] [-RoleName <String>] [ -AccessToken <string>]

After the above cmdlet is executed, a session is created for the respective user to execute further SnapCenter
cmdlets.

SnapCenter MFA Rest API Authentication

Use bearer token in the format Authorization=Bearer <access token> in REST API client (like Postman or
swagger) and mention the user RoleName in the header to get a successful response from SnapCenter.

MFA Rest APl Workflow

When MFA is configured with AD FS, you should authenticate using an access (bearer) token to access the
SnapCenter application by any Rest API.

About this task

* You can use any REST client like Postman, Swagger Ul or FireCamp.
« Get an access token and use it to authenticate subsequent requests (SnapCenter Rest API) to perform any
operation.
Steps
To authenticate through AD FS MFA
1. Configure the REST client to call AD FS endpoint to get the access token.

When you hit the button to get an access token for an application, you will be redirected to the AD FS SSO
page where you must provide your AD credentials and authenticate with MFA. 1. In the AD FS SSO page,
type your username or email in the Username text box.

+ Usernames must be formatted as user@domain or domain\user.

2. In the Password text box, type your password.
3. Click Log in.

4. From the Sign-in Options section, select an authentication option and authenticate (depending on your
configuration).

o Push: Approve the push notification that is sent to your phone.

> QR Code: Use the AUTH Point mobile app to scan the QR code, then type the verification code shown
in the app

> One-Time Password: Type the one-time password for your token.
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5. After successful authentication, a popup will open that contains the Access, ID, and Refresh Token.
Copy the access token and use it in the SnapCenter Rest API to perform the operation.

6. In the Rest API, you should pass the access token and role name in the header section.

7. SnapCenter validates this access token from AD FS.
If it is a valid token, SnapCenter decodes it and gets the username.
8. Using the Username and Role Name, SnapCenter authenticates the user for an API execution.

If the authentication succeeds, SnapCenter returns the result else an error message is displayed.

Enable or disable SnapCenter MFA functionality for Rest API, CLI, and GUI

GUI
Steps

1. Log into the SnapCenter Server as the SnapCenter Administrator.
2. Click Settings > Global Settings > MultiFactorAuthentication(MFA) Settings
3. Select the interface (GUI/RST API/CLI) to enable or disable the MFA login.

PowerShell interface
Steps
1. Run the PowerShell or CLI commands for enabling MFA for GUI, Rest API, PowerShell, and SCCLI.

Set-SmMultiFactorAuthentication -IsGuiMFAEnabled -IsRestApiMFAEnabled
-IsCliMFAEnabled -Path

The path parameter specifies the location of the AD FS MFA metadata xml file.

Enables MFA for SnapCenter GUI, Rest API, PowerShell, and SCCLI configured with specified AD FS
metadata file path.

2. Check the MFA configuration status and settings by using the Get-SmMultiFactorAuthentication
cmdlet.

SCCLI Interface
Steps

1. # sccli Set-SmMultiFactorAuthentication -IsGuiMFAEnabled true
-IsRESTAPIMFAEnabled true -IsCliMFAEnabled true -Path
"C:\ADFS metadata\abc.xml"

2. 4 sccli Get-SmMultiFactorAuthentication
REST APlIs

1. Run the following post API for enabling MFA for GUI, Rest API, PowerShell, and SCCLI.

19



Parameter

Requested URL

HTTP method

Request Body

Response Body

Value

[api/4.9/settings/multifactorauthentication
Post

{ "IsGuiMFAEnabled": false,
"IsRestApiMFAEnabled": true, "IsCliIMFAEnabled":
false, "ADFSConfigFilePath":
"C:\\ADFS_metadata\\abc.xml" }

{ "MFAConfiguration": { "IsGuiMFAEnabled": false,
"ADFSConfigFilePath":
"C:\\ADFS_metadata\\abc.xml",
"SCConfigFilePath": null, "IsRestApiMFAEnabled":
true, "IsCliMFAEnabled": false, "ADFSHostName":
"win-adfs-sc49.winscedom2.com” } }

2. Check the MFA configuration status and settings by using the following API.
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Parameter

Requested URL

HTTP method

Response Body

Value

/api/4.9/settings/multifactorauthentication
Get

{ "MFAConfiguration": { "IsGuiMFAEnabled": false,
"ADFSConfigFilePath":
"C:\\ADFS_metadata\\abc.xml",
"SCConfigFilePath": null, "IsRestApiMFAEnabled":
true, "IsCliIMFAEnabled": false, "ADFSHostName":
"win-adfs-sc49.winscedom2.com" } }
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